
Pokemon Colosseum RNG Guide by Jellal

This guide will explain how to RNG Pokemon Colosseum using emulators. It is based on my
experience and what I've picked after years of extensive research, so I don't claim it to be
exhaustive or entirely accurate. As a minimum, I recommend having experience on how to
RNG Gamecube games previously (XD) as well as advanced knowledge on how to operate
with Dolphin & VBA (Visual Boy Advance). Keep in mind that the images shown might differ
from what you actually have, regardless, the process should be the same.

Prerequisites:
In order to RNG abuse Pokemon Colosseum you will need:

● PokeFinder
● An ISO of Pokemon Colosseum
● Dolphin version 4.0-6848. (This version is known to work with RTC for Colosseum)
● RunAsDate (x64)
● A calculator

You might have heard about the Gamecube Pokemon games. Known for being overly
expensive on sites such as eBay and Amazon, currently it becomes very difficult to obtain
one of these and let alone get a shiny Shadow Pokemon. Pokemon Colosseum is also very
well known for being very impractical to RNG abuse on retail since, unlike XD, there is no
way to tell your current PRNG from your character’s movement and you’ll be relying on
finding your initial seed from a random generated party in Colossuem mode. However, when
done on a computer, it becomes a much more easier process since you’ll be able to see
your current PRNG live as you advance frames.

I will not cover TID/SID abuse since I assume this is something you have done before
reading this guide. In case you haven’t, please check Threw1’s guide on Colo ID abuse
before continuing from this point as you will need it in case you are abusing for a specific
shiny & flawless spread.

Setting up your work

Open Pokefinder and click on Stationary on the Gen 3 column:

● Go to Profile > Manager > Click on “New” and fill out your Pokemon Colosseum’s
data. Make sure you pick “Colosseum” as the game as otherwise you won’t be able
to search through Colo/XD Method.

https://github.com/Admiral-Fish/PokeFinder/releases
http://imgur.com/byn7Kfb
https://es.dolphin-emu.org/download/dev/21a70903ed8cd9c209049090529206b6860f105f/
https://www.nirsoft.net/utils/run_as_date.html
https://www.reddit.com/r/pokemonrng/comments/757m0y/colosseum_tidsid_rng_guide_emulator/


● Once done, click on “Accept” and once back on Profile Manager, click on “Done.”
● On the Gen 3 Stationary Window, now pick your new profile and PokeFinder will

automatically pick Colo/XD as the Search method. You should be able to see it as
shown in the screenshot below:

Configuration

We need to set up Dolphin appropriately for this RNG since we will be working on an
outdated version that will allow us to use RTC only with RunAsDate.

● On RunAsDate, on “Application to run” pick the path where your Dolphin.exe is
located on your computer.

● On “Date / Time” make sure that Absolute date / time is picked. Don’t touch the
dates yet.



● On “Parameters” type: “ -d “. This is extremely important as this will trigger the
Developer Mode of Dolphin when we start it from RunAsDate since the old version of
Dolphin lacks the RTC function the newer versions have.

● Make sure that any other checkbox else is unticked / unchecked.

Your RunAsDate window should look into something similar to this:

Contrary to what the screenshot shows, we will be picking 1/1/2000 at 12:00:00 AM as the
Date / Time to be used on RunAsDate in order to figure out our initial seed and hit a desired
spread. If you have used TogamiCalc on the old RNG Reporter, you’ll know what I am talking
about.

● Click on Run and you should be able to see Dolphin’s developer mode booting up
from start up. If not, make sure you have the right directory path.

● On Dolphin, open your game (Developer mode pauses your game from boot, but
don’t unpause yet) go to View and check Watch. You should be able to see on the left
side a gray square with some black colored rows.

● On address, enter the following numbers and you should be able to see the cell
getting white at the moment you enter the values. Make sure you label them properly
so you know which value you are looking at. These will be the PRNG states you will
need to RNG Colo:



US Colosseum:

○ Main PRNG: 80478c90
○ AI Slot 1: 80473070
○ AI Slot 2: 804731a8
○ AI Slot 3: 804732e0
○ AI Slot 4: 80473418
○ AI Slot 5: 80473550
○ AI Slot 6: 80473688

PAL Colosseum:

○ Main PRNG: 804c6130
○ AI Slot 1: 804c0508
○ AI Slot 2: 804c0640
○ AI Slot 3: 804c0778
○ AI Slot 4: 804c08b0
○ AI Slot 5: 804c09e8
○ AI Slot 6: 804c0b20

JPN Colosseum:

○ Main PRNG: 80464360
○ AI Slot 1: 8045e750
○ AI Slot 2: 8045e888
○ AI Slot 3: 8045e9c0
○ AI Slot 4: 8045eaf8
○ AI Slot 5: 8045ec30
○ AI Slot 6: 8045ed68

● Click on the Save button with the screw image and your RAM Watch table will be
saved on Dolphin. This way, we do not have to re-enter these values each time we
boot our game. It should look into something similar to this:



● Now unpause your game and press pause again. Check your PRNG state and this
should be your initial seed.

As you can see on the screenshot, on the PRNG row, 026AEC80 is my initial seed at
1/1/2000 at 12:00:00 AM. Make sure you save this value on a notepad or sticky note as we
will be using it each time we will RNG abuse Colo in the future. At this point you can close
your game window but make sure you keep the big window with our RAM Watch still open.

The RNG Process

Since I have already abused for an ID, on this case, I will be aiming for a Bold:
31/5/31/30/31/31 spread that will be shiny with my ID. To get the initial seed required to hit



your spread at a comfortable frame range, we will need to find the seed that generates your
spread:

● On the main PokeFinder window, go to Gen 3 Tools > IVs to PID
● Enter the IVs and Nature of the spread you are looking for. On my case, since I

already abused my ID to make my spread shiny, I will just be entering my own
information.

● On the results table, click on Seed and then press Ctrl + C to copy that value as we
will be needing it.

● Now open the Gamecube RTC window (Gen 3 Tools). Enter your initial seed
obtained at 1/1/2000. On Target seed, enter the seed you obtained from the IVs to
PID window. Enter a frame range where you feel comfortable waiting for (I’d
recommend setting 4000 as a min and you can set up a max of whichever you feel
like). Then click on Search and wait for the results.

● Once done, the Gamecube RTC will give you the time you need to set up on
RunAsDate in order to boot your game with the specific initial seed required to hit
your spread. On my case, I will have to change the RTC on 2:07:15 AM at 1/1/2000.

● Now change your RunAsDate’s date and time values to the ones shown in
Gamecube RTC.

● Now change your RunAsDate’s date and time values to the ones shown in
Gamecube RTC.

Once you boot up your game, you should be able to see the PRNG state on the RAM Watch
matching the same seed value shown on the Gamecube RTC window. If these values do not
match, make sure you are either using a compatible Dolphin version with RunAsDate, the
correct Date / Time or the PRNG value.



Now go to the Gen 3 stationary window of PokeFinder and enter your new initial seed. Enter
your spread information, load your profile and hit on Calculate. As you can see, our target
frame is 770742.

When you are done, it is time to start with our Shiny Colosseum RNG hunt. On my case, I
will be RNG abusing the legendary Pokemon Suicune! Depending on the place and the
Pokemon you are targeting some Shadows might be easier or harder to RNG for. On this
case, Suicune is on a noiseless area which means that on the place where it is encountered,
the PRNG will not move at all which makes it perfect for beginners to start with:

● Boot your game and enter into the game’s overworld. Since Colosseum saves from
the PC make sure you are booting from a point where you can reach the location of
your Shadow Pokemon without exceeding from your target frame.



● Once you have reached the place where you encounter the Pokemon you intend to
RNG, create a save state.



● Depending on the area you are RNGing before the encounter, there are several ways
you can advance your PRNG accordingly and adjust in order to get close to your
target frame.

○ On noiseless areas:
■ Over 10,000 frames: You can check a Shadow Pokemon’s summary

either on the Shadow Monitor or in your party. The Shadow particles
advance A LOT of frames, so make sure you keep a close track and
pause accordingly before you exceed your target frame

■ Less than 3,000 frames: You can advance frames by just viewing a
regular Pokemon’s summary. If there is movement, they will advance
a certain amount of frames.

■ Less than 500 frames: By going back and forth from the PDA Menu to
the Shadow Monitor, you are advancing exactly 7 frames which makes
it perfect once you are closing into your target frame.

○ On noisy areas:
■ Bayleff method: By checking back and forth the summary of two

non-shadow Pokemons you can change how frequently the PRNG is
advancing on noisy areas. It is recommendable to do this with Espeon
& Umbreon on your summary since both DO NOT advance the PRNG
on their summary screens which makes the advancement minimal
when swapping summaries.

○ During battles:
■ Sometimes, you will be stuck on situations where you will have to

advance the PRNG while being on a battle. A notable example are the



final 6 Shadow Pokemon on Realgem Tower. You’ll have to advance
frames while battling the previous trainer before your target Shadow
Pokemon. Attacks with longer animations such as Solarbeam or Fire
Blast will consume a lot of PRNG, while others like Body Slam use
less. Plan accordingly before facing these Pokemons.

It’s worth mentioning that on noisy areas, we do not have control on how the PRNG will
advance even if we change the advancements and you will just have to hope you hit the
correct PRNG state that will trigger your spread. However, since we are doing this on a
noiseless area, we can control the advancements. Take into account that since there are
other variables that might influence the RNG such as forced dialogues or scenes before the
encounter is triggered, this may influence as well how your PRNG advances and the frames
you are trying to hit.

● Advance frames accordingly using the techniques I have shared earlier. Make save
states as you keep getting closer to your target.

● Since we are on a noiseless area, we need to hit our target frame 5 frames earlier
which is where our shiny spread will generate. As you can see on the screenshot
below, I am on 222 frames away from target. If you subtract 222 - 5, this will give you
217 frames. Divide this by 7 (the amount of frames opening and closing the Shadow
Monitor advance the PRNG) and it gives you 31. This means that in order to hit our
target of 5, we will have to open and close the Shadow Monitor 31 times.



● Once you are on the intended target frame (5 frames away from target) trigger the
encounter and you should be able to see your spread on the corresponding Shadow
Pokemon’s AI slot. Since Suicune is the 5th Pokemon on Venus’ team, you should be
able to see it on Slot 5.

● To double check, enter the PRNG address of the corresponding slot on Memory View
(View > Memory) and you should be able to see the Pokemon’s name scribbled all
over on ASCI View (Right click > View > As ASCI)



● From this point forward, since once you encounter a Shadow Pokemon, its PID and
IVs are stored, you can either KO the Pokemon to capture it later. Once you are on
post-game you can export Dive / Repeat / Luxury Balls from the mainline GBA
games and use it to capture your Shiny Shadow Pokemon.

● If that is not your cup of tea, capture it and once the battle is over, you can now watch
your Shiny Shadow Pokemon in all of its glory. You’ll notice the difference when you
check the party sprites since shiny sprites are always different from non-shinies.



Congratulations! You are now the proud owner of a Shiny Shadow Pokemon. All that is left is
purify it and enjoy your Colosseum Shiny.

What now?

You can check Jay’s guide on how to connect Dolphin to VBA to transfer your Colosseum
RNG to your Gen 3 Pokemon games.

https://www.reddit.com/r/pokemonrng/comments/3e526e/a_guide_to_using_joybus_to_emulate_gcgba_link/

